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CE Mark

The CE marking applied to this product symbolises Rank Xerox’s declaration of conformity with the following applicable directives of the European Union as of
the dates indicated.
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voltage equipment.
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WARNING: In order to allow this equipment to operate in proximity to industrial, scientific, and Medical (ISM) equipment, the external radiation from
ISM equipment may have to be limited or special migration measures taken.

WARNING: This is a Class A product. In a domestic environment this product may cause radio interference, in which case the user may be required to
take adequate measures.

FCC Information

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void
the user’s authority to operate this equipment.

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates,
and uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to cause interference in which case the user will be required to correct the interference
at his own expense.

Industry Canada Class A Notice

This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus as set out in the interference-causing equipment standard
entitled, “Digital Apparatus” ICES-003 from Industry Canada.

Avis de Conformation Classe A d I'Industrie Canada

Le présent appareil numérique n'émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de la Classe A prescrites dans la
norme sur le matériel brouilleur, “Appareils Numériques” NMB-003 édictée par I'Industrie Canada.

Certificate by Manufacturer/Importer

This is to certify that the FCO7 is shielded against radio interference in accordance with the provisions of VFG 243/1991. The German Postal Services have been
advised that this device is being put on the market and that they have been given the right to inspect the series for compliance with the regulations.
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Bescheinigung des Herstellers/Importeurs

Heirmit wird bescheinigt, dass der FCO7 im Uebereinstimmung mit den Bestimmungen der VFG 243/1991 Funk-Entstort ist. Der Deutschen Bundespost wurde
das Inverkehrbringen dieses Geraetes angezeigt und die Berechtigung zur Ueberpruefung der Serie auf Einhaltung der Bestimmungen eingeraumt.
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RFI Compliance Notice

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal
operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user
who is responsible for compliance of his particular installation.

Dieses Geraet wurde einzeln sowohl als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funk-entstoerbestimmungen
geprueft. Es ist jedoch moeglich, dass die Funk-enstoerbestimmungen unter unguenstigen Umstaenden bei anderen Geraetekombinationen nicht eingehalten
werden. Fuer die Einhaltung der Funk-entstoerbestimmungen seigner gesamten Anlage, in der dieses Geraet betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.



Einhaltung mit betreffenden Bestimmungen kommt darauf an, dass geschirmte Ausfuhrungen gebraucht werden. Fuer die beschaffung richtiger Ausfuhrungen
ist der Betreiber verantwortlich.

Software License Agreement

Before using the Software, please carefully read the following terms and conditions. BY USING THIS SOFTWARE, YOU SIGNIFY THAT YOU HAVE
ACCEPTED THE TERMS OF THIS AGREEMENT. If you cannot or do not accept these terms, you may return the entire package within ten (10) days to
the Distributor or Dealer from which you obtained them for a full refund.

Electronics for Imaging, Inc. grants to you a non-exclusive, non-transferable license to use the software and accompanying documentation (“Software”) included
with the Fiery X2 you have purchased, including without limitation the PostScript® software provided by Adobe Systems Incorporated.

You may:

a. use the Software solely for your own customary business purposes and solely with Fiery X2;

b. use the digitally-encoded machine-readable outline and bitmap programs (“Font Programs”) provided with Fiery X2 in a special encrypted format (“Coded
Font Programs”) to reproduce and display designs, styles, weights, and versions of letters, numerals, characters and symbols (“Typefaces”) solely for your own
customary business purposes on the display window of the Fiery X2 or monitor used with Fiery X2;

c. use the trademarks used by Electronics for Imaging to identify the Coded Font Programs and Typefaces reproduced therefrom (“Trademarks”); and

d. assign your rights under this Agreement to a transferee of all of your right, title and interest in and to Fiery X2 provided the transferee agrees to be bound by
all of the terms and conditions of this Agreement.

You may not:

a. make use of the Software, directly or indirectly, to print bitmap images with print resolutions of 600 dots per inch or greater, or to generate fonts or typefaces
for use other than with Fiery X2;

b. make or have made, or permit to be made, any copies of the Software, Coded Font Programs, accompanying documentation or portions thereof, except as
necessary for use with the Fiery X2 unit purchased by you; provided, however, that under no circumstances may you make or have made, or permit to be made,
any copies of that certain portion of the Software which has been included on the Fiery X2 hard disk drive. You may not copy the documentation;

c. attempt to alter, disassemble, decrypt or reverse engineer the Software, Coded Font Programs or accompanying documentation.

d. rent or lease the Software.

Proprietary Rights

You acknowledge that the Software, Coded Font Programs, Typefaces, Trademarks and accompanying documentation are proprietary to Electronics for Imaging
and its suppliers and that title and other intellectual property rights therein remain with Electronics for Imaging and its suppliers. Except as stated above, this
Agreement does not grant you any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), or any other rights, franchises or
licenses in respect of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation. You may not adapt or use any trademark or
trade name which is likely to be similar to or confusing with that of Electronics for Imaging or any of its suppliers or take any other action which impairs or reduces
the trademark rights of Electronics for Imaging or its suppliers. The trademarks may only be used to identify printed output produced by the Coded Font
Programs. At the reasonable request of Electronics for Imaging, you must supply samples of any Typeface identified with a trademark.

Confidentiality

You agree to hold the Software and Coded Font Programs in confidence, disclosing the Software and Coded Font Programs only to authorized users having a need
to use the Software and Coded Font Programs as permitted by this Agreement and to take all reasonable precautions to prevent disclosure to other parties.

Remedies

Unauthorized use, copying or disclosure of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation will result in automatic
termination of this license and will make available to Electronics for Imaging other legal remedies.

Limited Warranty And Disclaimer

Electronics for Imaging warrants that, for a period of ninety (90) days from the date of delivery to you, the Software under normal use will perform without
significant errors that make it unusable. Electronics for Imaging’s entire liability and your exclusive remedy under this warranty (which is subject to you returning
Fiery X2 to Electronics for Imaging or an authorized dealer) will be, at Electronics for Imaging’s option, to use reasonable commercial efforts to attempt to correct
or work around errors, to replace the Software with functionally equivalent software, or to refund the purchase price and terminate this Agreement. Some states
do not allow limitations on duration of implied warranty, so the above limitation may not apply to you.



Except for the above express limited warranty, Electronics for Imaging makes and you receive no warranties or conditions on the Products, express, implied, or
statutory, and Electronics for Imaging specifically disclaims any implied warranty or condition of merchantability or fitness for a particular purpose.

For warranty service, please contact your authorized service/support center.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, ELECTRONICS FOR IMAGING MAKES AND YOU RECEIVE NO WARRANTIES
OR CONDITIONS ON THE SOFTWARE OR CODED FONT PROGRAMS, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION
OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND ELECTRONICS FOR IMAGING SPECIFICALLY DISCLAIMS ANY IMPLIED
WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Electronics for Imaging does not warrant that
the operation of the software will be uninterrupted or error free or that the Software will meet your specific requirements.

Limitation Of Liability

IN'NO EVENT WILL ELECTRONICS FOR IMAGING OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES, INCLUDING LOSS OF DATA, LOST
PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES ARISING FROM THE USE OF
THE SOFTWARE, CODED FONT PROGRAMS OR ACCOMPANYING DOCUMENTATION, HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY. THIS LIMITATION WILL APPLY EVEN IF ELECTRONICS FOR IMAGING OR ANY AUTHORIZED DEALER HAS BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE UNIT REFLECTS THIS ALLOCATION OF RISK.
BECAUSE SOME STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Export Controls

You agree that you will not export or re-export the Software or Coded Font Programs in any form without the appropriate United States and foreign government
licenses. Your failure to comply with this provision is a material breach of this Agreement.

Government Use

Use, duplication or disclosure of the Software by the United States Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of the Rights in
Technical Data and Computer Software clause at DFARS 252.227-7013 or in subparagraphs (c) (1) and (2) of the Commercial Computer Software—Restricted
Right Clause at 48 CFR 52.227-19, as applicable.

Third Party Beneficiary

You are hereby notified that Adobe Systems Incorporated, a California corporation located at 345 Park Avenue, San Jose, CA 95110-2704 (“Adobe”) is a third-
party beneficiary to this Agreement to the extent that this Agreement contains provisions which relate to your use of the Fonts, the Coded Font Programs, the
Typefaces and the Trademarks licensed hereby. Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to Electronics
for Imaging.

General
This Agreement will be governed by the laws of the State of California.

This Agreement is the entire agreement held between us and supersedes any other communications or advertising with respect to the Software, Coded Font
Programs and accompanying documentation.

If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions concerning this Agreement, please write to Electronics for Imaging, Inc., Attn: Licensing Dept. or see Electronics for Imaging’s web site
at www.efi.com.

Electronics for Imaging, Inc.
2855 Campus Drive
San Mateo, CA 94403
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About the documentation

This manual describes how to install the user software for the Fiery X2 Color Server™
and set up printing from Windows and Mac OS computers. For information about
setting up network servers and clients to use the Fiery X2 Color Server, see the
Administrator Guide. For general information on using the color copier, your
computer, your application software, or your network, see the manuals that accompany
those products.

NoTe: The term “Fiery X2” is used to refer to the Fiery X2 Color Server.

The Fiery X2 supports Empress (5750), Regal (5790), and Countess (5799) digital
copier printers.

Your Fiery X2 includes a media pack containing the following:

» User Software CD

System Software CD

« User Documentation CD

Kodak Gray Scale package

Printed Release Notes (described below)

Quick Start Notes

About the documentation

This manual is part of the set of Fiery X2 documentation, which includes the following
manuals for users and system administrators:

« The Administrator Guide explains basic configuration and administration of the
Fiery X2 for the supported platforms and network environments. It also includes
guidelines for setting up UNIX, Windows NT, and Novell NetWare servers to
provide Adobe PostScript printing services to clients.

* Getting Started describes how to install software to enable users to print to the
Fiery X2. Specifically, it describes installation of PostScript printer drivers, printer
description files, and other software provided on the User Software CD. It also
explains how to connect each user to the network.
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< The User Guide describes the printing features of the Fiery X2 for users who send
jobs via remote workstations on the network or via a direct parallel port connection.
It also explains how to use the Fiery WebTools and Fiery X2 client utilities to
manage jobs and maintain color quality, and provides troubleshooting information
for problems that may arise.

« Release Notes provide last-minute product information and workarounds for some of
the problems you may encounter.

Specifications

The Fiery X2 has the following features:

* MIPS R5000, 200 MHz CPU

» 160MB RAM

* Internal 2GB hard disk drive

 External CD-ROM drive (available as an optional kit)

e SCSI port

« Supports AppleTalk, TCP/IP, and IPX protocols simultaneously
« Supports parallel port communication

« Supports thinnet (thin coaxial Ethernet cable or 10Base2), thicknet (thick coaxial
Ethernet cable or 10Base5), and unshielded twisted pair (Fast Ethernet 100Base T X
or Ethernet 10BaseT)

« Supports Token Ring networking (available as an optional kit)
« Supports Adobe PostScript 3
« Includes 136 fonts (117 Adobe Type 1 PostScript and 19 TrueType)

In addition, two Adobe Multiple Master fonts are included and are used for font
substitution in PDF files.

« Built-in ColorWise™ color management and NetWise™ networking features
* Fiery WebTools™
« Fiery Downloader™, Fiery Print Calibrator™, and Fiery Spooler™ client utilities

« Fiery Scan™ plug-in
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User software

User software

The full set of Fiery X2 user software is provided on the User Software CD. Installers
for the printer files can also be downloaded with the Installer WebTool.

Adobe PostScript Printer
Driver

PostScript Printer Description
files (PPDs)

PostScript Screen Fonts

Fiery Downloader

Fiery Print Calibrator

Fiery Spooler

Fiery Scan plug-in

Enables you to print to the Fiery X2 from Windows
3.1x, Windows 95, and Mac OS computers;
supports special Fiery X2 and PostScript 3 features.

Files for use with the PostScript printer driver; they
allow the Fiery X2 to appear in popular applications’
Print and Page Setup dialog boxes. The Fiery X2
PPDs provide information about the Fiery X2 and
your particular copier model to the application and
printer driver you are using.

Screen fonts for the 136 PostScript printer fonts
installed on the Fiery X2 (117 Adobe Type 1 and 19
TrueType). See Appendix B of the User Guide for a
complete list.

Enables you to print PostScript files, Encapsulated
PostScript (EPS) files, and Portable Document
Format (PDF) files directly to the Fiery X2 without
opening the application in which they were created.
Fiery Downloader also enables you to manage the
printer fonts installed on the Fiery X2.

Enables you to calibrate the Fiery X2 remotely from
your computer. Proper calibration keeps color
consistent across time.

Enables you to view the order and priority of print

jobs, customize printer settings for jobs, delete jobs,
and move jobs between queues. You can also use it

to view job accounting information.

A TWAIN plug-in module for Photoshop that
enables you to scan images from the copier directly
into Photoshop.
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Color management files ColorSync and ICM color management files that
enable you to maintain consistent color from your
original artwork to the colors displayed on your
monitor to the printed output.
Color reference files Reference pages that you can print to view the range

of colors available on your Fiery X2. For the most
predictable color results, refer to these pages when
defining colors in applications.

System requirements

To install the Fiery X2 user software on a Windows or Mac OS computer, the
computer must be equipped with a built-in or external CD-ROM drive.

Windows

To print to the Fiery X2, you need:

« A Windows-based computer with an 80486, AMD, or Pentium processor
» Windows 95, Windows 3.1x, or Windows NT 4.0

* At least 4AMB of RAM

To use Fiery utilities (Fiery Downloader, Fiery Print Calibrator, and Fiery Spooler) you
also need:

» Either Windows 95 or Windows NT 4.0 with NT Service Pack 3
* At least 16 MB of RAM

To use Fiery Scan, you also need Adobe Photoshop version 2.5 or later.

To use Fiery WebTools, you also need:

« Either Netscape Communicator v4.0.4 with Java enabled or Microsoft Internet
Explorer v3.0.2 with Java enabled

Note: Netscape and Microsoft continue to release frequent updates to their browsers.
As support cannot be guaranteed for all versions, use the versions specified above for
best results.
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« A monitor that supports 16-bit color at a minimum resolution of 800 x 600
e A TCP/IP enabled network and the IP address or DNS name of the Fiery X2
« Web Services enabled on the Fiery X2

Note: Fiery utilities and Fiery WebTools are not supported with Windows 3.1x.

With Microsoft Windows 95, you also need:
e |PX/SPX or TCP/IP networking protocol installed

Note: You must have TCP/IP networking protocol installed in order to use Fiery
Spooler; Fiery Spooler is not supported over IPX/SPX.

 Adobe PostScript Printer Driver for Windows version 4.2 or later (version 4.2.2 is
included with the user software)

With Microsoft Windows 3.1x, you also need:

« IPX networking protocol installed

« IPX/SPX networking software for IPX/SPX communication
* MS-DOS version 5.0 or later

 Adobe PostScript Printer Driver for Windows version 3.0 or later (version 3.0.1 is
included with the user software)

With Microsoft Windows NT 4.0 you also need:
e TCP/IP or AppleTalk networking protocol installed

« The Windows PostScript Printer Driver that came with your Windows NT 4.0
system software; however, some Fiery X2 printing features may not be available. For
details, see the User Guide.

Mac OS
To print to the Fiery X2, you need:

e A Mac OS-based computer
At least 8BMB of RAM
e EtherTalk installed
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* Apple System software version 7.5 or later

« Adobe PostScript Printer Driver version 8.5 or later (version 8.5.1 is included with
the user software)

To use the Fiery utilities (Fiery Downloader, Fiery Print Calibrator, and Fiery Spooler),
you also need:

« A Power Macintosh computer

* At least 16MB of RAM
To use Fiery Scan, you also need Adobe Photoshop version 2.5 or later.

To use Fiery WebTools, you also need:
 Netscape Communicator v4.0.4 with Java enabled

Note: Netscape continues to release frequent updates to its browser. As support cannot
be guaranteed for all versions, use the version specified above for best results.

e ATCP/IP enabled network and the IP address or DNS name of the Fiery X2
» \Web Services enabled on the Fiery X2

UNIX (TCP/IP)
To print to the Fiery X2 with a UNIX workstation, you need:

« A workstation with standard TCP/IP connectivity (for example, Sun SPARCstation
or Silicon Graphics workstation with Solaris version 2.x or SunOS version 4.1.x
software)

e TCP/IP printing software that conforms to RFC1179 (Berkeley Ipd protocol)

Parallel port
To print to the Fiery X2 using the parallel port, you need:

* A Windows-based computer with an 80486, AMD, or Pentium processor
At least AMB of RAM
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System requirements

« The parallel cable included with the Fiery X2

The cable has a DB-25 male connector (that connects to the computer) on one end
and a DB-25 female connector (that connects to the Fiery X2) on the other.

IPX (Novell)

To use the Fiery X2 with an IPX (Novell) network, you need:
* A Novell server

» Novell NetWare software version 4.x or 3.x

 Support for Ethernet SNAP, Ethernet 11, Ethernet 802.3, Ethernet 802.2,
Token Ring SNAP, or Token Ring
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User Software
on a Windows
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Installing Windows software

This chapter describes installing software and setting up printing from a
Windows-based computer running Windows 95, Windows 3.1x, or Windows NT 4.0.

The general steps for installing the Fiery X2 software are:

« Install the Adobe PostScript printer driver (Windows 95 and Windows 3.1x) or
Windows PostScript printer driver (Windows NT 4.0) and PostScript Printer
Description files (PPDs) (for all Windows systems).

« Set up the printer driver to communicate with the Fiery X2.

« Install the Fiery utilities (Fiery Downloader, Fiery Print Calibrator, and
Fiery Spooler) and Fiery Scan plug-in (Windows 95 and Windows NT 4.0 only).

 Configure the connection for Fiery Downloader, Fiery Print Calibrator, and Fiery
Scan.

« Configure the connection for Fiery Spooler.

« Copy additional color reference and application files from the User Software CD as
needed.

Installing Windows software

The Instalrs folder on the User Software CD contains the following installer folders:
 Calib—TFiery Print Calibrator installer

« Download—Fiery Downloader installer

PS_drvr—Adobe PostScript printer driver installers for Windows 95 and
Windows 3.1x, and Fiery X2 PPD files for all supported Windows systems

Scan—TWAIN module installer, which enables you to use the Fiery Scan plug-in
for Adobe Photoshop

Spooler—*Fiery Spooler installer
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Installing User Software on a Windows Computer

In addition, the User Software CD includes various color files. These files must be
copied or installed from the CD and placed in the appropriate locations on your hard
disk (see “Copying color files from the User Software CD” on page 42):

e ICM printer profile
« Separation Tables and a monitor settings file for use with Adobe Photoshop

« PostScript CMYK reference file

PostScript PANTONE Coated Color Reference file

RGB color reference files for specifying colors from Microsoft Word and PowerPoint

Downloading printer files with the Installer WebTool

Installers for the Fiery X2 printer files can be downloaded from the Fiery X2 with the
Installer WebTool (if the site administrator has enabled Internet access to the
Fiery X2). For instructions, see “Using the Installer WebTool” on page 64.

Once you download the installers, the installation process is identical to installing from
the User Software CD.

Setting up the Fiery X2 as a PostScript printer

To set up the Fiery X2 as a PostScript printer, you need a PostScript printer driver and
the appropriate Fiery X2 PPD file.

« For Windows 95 or Windows 3.1, install the appropriate Adobe PostScript printer
driver, included with the Fiery X2 user software. Both drivers are capable of
providing access to all Fiery X2 features; in addition, the Adobe PostScript printer
driver for Windows 95 supports PostScript 3.

« For Windows NT 4.0 systems, install the printer driver that came with your
Windows system software. This driver may not support all Fiery X2 features.

The following procedures are specific to each version of Windows.
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Setting up PostScript printing with Windows 95

You can use the following procedure whether you are installing from the User Software
CD or with installer files downloaded using the Installer WebTool.

Note: If you have problems setting up the Fiery X2, install another PostScript printer
such as the Apple LaserWriter, and then install the Fiery X2.

TO INSTALL THE ADOBE POSTSCRIPT PRINTER DRIVER FOR WINDOWS 95:

1.

If you are installing from the CD, insert it into the CD-ROM drive and double-click the
icon of the CD.

If you are installing from the files you downloaded using the Installer WebTool,
double-click the icon of your hard disk drive.

If you are installing from the CD, open the English\Instalrs\Ps_drvr folders.

If you are installing from the files you downloaded using the Installer WebTool, open
the Prntdrv\Ps_drvr folders on your hard disk.

Open the Win_95 folder, and double-click the Setup.exe icon.

Read the End User License Agreement. If you agree with the terms and conditions of
the agreement, click Accept.

You must click Accept before setup can continue. If you click Decline, you are
prompted to either continue with setup or exit.

Click Read to view the README file. When you are finished, close the README file and
click Next.

AdobePS 4.2 PostScript Printer Driver Setup m

This program will help you add & PostScript printer to your system
Aeloke

The installation disk contains the file ReadMe that provides additional

infomation about the Adobe PostScript Printer Driver.

<SEEEk Dlext > Exit Help
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The information in this file is not specific to your Fiery X2. You can click Next to
postpone reading this file and read it later.

If you are installing from the CD, you may see an Install Setup Program dialog box
offering you the option to copy the setup program to your hard disk. Make your choice
and then click Next.

Some printer files are installed to your hard disk.

In the Printer Type dialog box, select Local Printer and click Next.

This is a general installation. You can modify the attachment later, according to your
network type.

Printer Type m

@ Haw is the printer attached to wour computer?

Ifitis directly attached to your computer, click Local Printer.
lf itis attached to another computer, click Network Printer.

@ Local Prmtelf

" Metwork Printer

< Back | Dlext > I Exit | Help |

If you are installing from the CD, in the Directories box, open the
English\Instalrs\Ps_drvr\Win_95 folders.

If you are installing from the installer files you downloaded with the Installer
WebTool, in the Directories box, open the Prntdrv\Ps_drvr\Win_95 folders.

Install PostScript Printer from PPD E
Directories: FPostzcript Printer descriptions [FPD's] available:
evmi] Dhmerox_mxhuser_swhenglishiinstalrshps_drerhwin 95

et a | |Fiery <2 5750 +3010.104 -
&3 mxl0 Fiery 2 5730 +3010.104 _I
Fi v3010.104
2] werow_ms
) user_sw
4 english =l
Dirives: _I
I He j
EFM<FOI0.PPD  GB7EE0 5-21-193811:12:38 Metwork. .. |

< Back | Mest » I Exit Help |
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9. The Fiery X2 PPD appear in the Postscript Printer descriptions (PPDs) available box.
Select the Fiery X2 PPD file for your copier and click Next.

For the 5750, select Fiery X2 5750 v3010.104.
For the 5790, select Fiery X2 5790 v3010.104.
For the 5799, select Fiery X2 5799 v3010.104.

10. In the Available ports box, select the LPT1 port and click Next.
You will configure the port later, according to your network type.

Local Port Selection m

2

Click the portyou want to use with this printer.
Click Configure Port to view or change that port's parameters

Awailable pors:

COM1 Communications Port

COM2 Communications Port
FIERY Prints o .
Creates a File on Disk

Configure Port
< Back Dlext > Exit Help
| | | |

11. Using a maximum of 20 characters, enter a name for the Fiery X2 (or leave the default

name) in the Printer Name box.

This name will be used in the Printers and queue windows.

Note: Entering more than 20 characters may cause printing problems with some

network applications.

Add Printer [ x]

&

“You can use the following name ar enter another name for this printer. You mey
use as many as 31 uppercase and lowercase characters or spaces.

Erinter Name: Astro
Do you want to use this printer as your default printer?
" Yes
“Ng
Would you like to print the test page?
 Yes (Recommended)
& Na

<Back | e > | Exit | Help |

12. If you want the Fiery X2 to be the default printer select Yes; if not, select No.
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14.

15.
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Select No to printing the test page and click Next.
You will print the test page after you finish configuring the printer.

The necessary files are installed to your hard disk. When installation is complete, the
Properties dialog box appears.

Click OK.
You are notified that Setup is complete.

Click Exit.
The icon for your newly installed printer appears in the Printers window.

You are ready for the instructions for connecting to your network type (see
“Completing the Windows 95 connection” below).

Completing the Windows 95 connection
To print from Windows 95 you need to:

 Set up network servers, if any
« Set up the Fiery X2 to accept print jobs from your computer

« Configure a port on each Windows 95 computer for the network or connection type

For this type of connection: See:
Parallel below

IPX/SPX page 10
IPX (Novell) page 12
SMB printing page 13

Completing the Windows 95 parallel port connection

Preparing a parallel port connection for Windows 95 requires specific BIOS settings
on your computer, and specific port and printer settings for Windows 95. In addition,
a change to one of the Fiery X2 Setup settings may be required if you choose to spool
files to the Fiery X2 rather than print directly.
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TO PREPARE THE FIERY X2 AND YOUR COMPUTER FOR PARALLEL PORT

PRINTING:

1.

Connect the Fiery X2 to the parallel port on your computer.

For instructions, see the Administrator Guide.

In Network Setup>Port Setup>Parallel Port Setup, set Enable Parallel Port to Yes.
For more information about Fiery X2 Setup, see the Administrator Guide.

If you want to spool files to the Fiery X2, set Port Timeout in Seconds to 10.

If you want to print directly to the Fiery X2, set Port Timeout in Seconds to 5.

Setting this option to 10 seconds ensures that spooling is not interrupted due to
timeout.

In your computer’s BIOS settings, set Parallel Port Mode to ECP.

To access the BIOS settings, restart the computer and press the key indicated on your
monitor as soon as the computer starts up. You may have to scroll through several
screens to reach the parallel port settings. After setting the Parallel Port Mode to ECP,
save your changed setting and exit.

TO PREPARE THE PRINTER FOR PARALLEL PORT PRINTING:

1.

2.

Click the Start button, point to Settings, and click Printers.
Click the Fiery X2 printer icon and choose Properties from the File menu.

Click the Details tab, and in the “Print to the following port” menu, select LPT 1: (ECP
Printer Port).

Note: Check this selection carefully. It may read LPT 1: (Printer Port), which is not
equivalent to LPT 1: (ECP Printer Port).

If this box does not read LPT 1: (ECP Printer Port), change the port setting now, as
described in “To prepare the port for parallel port printing:” on page 8, and then
return to this procedure. You may need your Windows 95 system CD.

If you changed the selection in the “Print to the following port” menu, click Apply.

A Warning dialog box may appear, stating that fonts you downloaded to the previously
selected port may be lost; click OK.



8 | Installing User Software on a Windows Computer

5. Click Spool Settings.

Spool Settings m

@ Spaol print joks 50 program finishes printing faster

" Start printing after last page is spooled
@ Start printing after first page is spaaled
" Print directly to the printer

Spool data format Ry j

" Enahle bi-directional suppartfar this printer
& Disable bi-directional support for this printer

0K | Cancel | Restore Defaults |

6. Select either “Spool print jobs so program finishes printing faster” or “Print directly
to the printer.”

The selection you make depends on the action you took in step 3 on page 7:

« If you set the Port Timeout in Seconds to 10, you can select either option; however,
spooling is faster.

« If you set the Port Timeout in Seconds to 5, select “Print directly to the printer.”
7. Select “Disable bi-directional support for this printer” and click OK.

8. Click Apply.

You are now ready to print from your applications to the Fiery X2 with the parallel
port. To confirm the connection, print a Windows 95 test page.

9. Click the General tab.

10. Click Print Test Page and click OK.

Perform the following procedure only if the LPT 1 port is not currently set to
ECP Printer Port.

TO PREPARE THE PORT FOR PARALLEL PORT PRINTING:
1. Click the Start button, point to Settings, and click Control Panel.

2. Double-click System.
The System Properties window appears.
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3. Click the Device Manager tab.
4. Double-click Ports.

System Properties m

General Dewvice Manager | Hardware Profiles | Performance'

& View devices by type  View davices by cannection

@, Computer

[+ COROM

- =0 Disk drives

t| @ Display acapters
-2y Floppy disk controllers
-2 Hard disk contrallers
t| @ Keyhoard

H
H
H
H
H
118 Monitor
[+ £7y Maouse
H
H
H
H
H
A

t| Metwork adapters
| '? Other devices

H-4e SCE| contrallers
t| Sound, videa and game contrallers

t System devices

Froperties | Refresh | Remove | Frint. |

oK | Cancal |

5. Double-click the port with (LPT1) in its name.
6. In the (LPT1) Properties dialog box click the Driver tab and then click Change Driver.
7. Select Show all devices.

8. From the Manufacturers list, select “(Standard port types).” From the Models list,
select “ECP Printer Port” (not Printer Port). Click OK.

Select Device n

. Click the Ports (COM LPT) that matches your hardware, and then click OK. Ifyou
don't know which maodel you have, click OK. If you have an installation disk far this
device, click Have Disk.

Manutacturers: hodels:

Communications Part

Hewlett Packard
M
Fockwell

SMART Modular Technologie
LI : LI_I
¢ Show compatible devices Hawve Disk

& Show all devices

Generic IRDA Compatible Device
Printer Port

oK | Cancal |
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9. Click OK in the (LPT1) Properties dialog box.

Note: You might need to insert the Windows 95 system CD to complete this step
depending on whether the required files are on your hard disk.

10. When prompted to restart the computer, click Yes.

After Windows 95 restarts, you can complete the procedure described in “To prepare
the printer for parallel port printing:” on page 7.

Completing the Windows 95 IPX/SPX or IPX (Novell) connection

If you are printing through a Novell server, the Novell network and file server should
be set up before you begin. The file server should be configured with a print server and
print connection for the Fiery X2. For details see your NetWare documentation and
the Administrator Guide.

You can also use Fiery Downloader to print directly to the Fiery X2 from Windows 95
with IPX/SPX.

To SET UP IPX/SPX PRINTING:
1. Open the Windows 95 Control Panel.

2. Double-click the Network icon.

Make sure that IPX/SPX-compatible Protocol and TCP/IP protocol are both listed in
the Installed Network Components section.

For instructions, see your Windows 95 documentation.
Note: You must enable TCP/IP printing to ensure that all files required for IPX/SPX

will be installed. You can select it and click Remove after you set up IPX/SPX if you do
not need to use the TCP/IP protocol.
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3. Double-click the IPX/SPX-compatible Protocol icon.

Metwork EHE

Configuration | Identificationl Aocess Eontroll

The following network components are installed:

Client for Microzoft Metworks

Client for Metware Metworks

3Com EtherLink [11 154 [3C509/3C503b) in 154 mode
|F/5F-compatible Protocal

TCRAP

Eemoye | Braperties |
Frimary Metwork Logomn:
IWindows Logon j
File and Frint Sharing... |
Drescription
()8 Cancel

4. Click the Advanced tab.
5. In the Property list, click Frame Type. In the Value pop-up menu, select the Frame
Type that corresponds to the one set during Fiery X2 Network Setup.

If necessary, print the Configuration page from the Control Panel to check which
Frame Type(s) are configured.
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Note: Do not select Auto. Doing so may not select the Frame Type specified on the
Fiery X2.

IPX/5PX-compatible Protocol Properties EHE

Bindings Advanced | NetBIns |

Click the setting vou want to change on the left, and then
zelect itz new value on the right.

Broperty: Walue:
Auto

Force Even Length Packets

M arimurn Connections
M arimurn Sockets
Metwork Address
Source Routing

[Ethemet 802.2
Ethernet 8023

Ethemet Il
Token Ring
Token Ring SHAP

I™ | St thie pratono] e ke the default pratosl

()8 I Cancel |

Click OK and close the Network Control Panel.

To SET UP IPX (NOVELL) PRINTING WITH WINDOWS 95:

1.

2.

Click the Start button, choose Settings, and then choose Printers.

Click the Fiery X2 icon, and choose Properties from the File menu (or right-click the
icon and left-click Properties).

Click the Details tab and click Add Port.
A list of connection options is displayed.

In the Add Port dialog box, specify the network path, or click Browse for a display of
your network environment.

If you are using a NetWare file server, double-click the icon of the NetWare file server
you want to use for printing to the Fiery X2 and click OK.

Click the printer icon labeled with the NetWare print queue you will use and click OK.
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10.

In the Add Port dialog box, verify that the network path is updated and click OK.

You are ready to print from the workstation. Your print jobs will be sent to the
specified print queue on the Novell file server. The Fiery X2 polls the file server and if
jobs are present, they are sent to the Fiery X2.

To confirm the connection, you can print a Windows 95 test page.
Click the General tab, and click Print Test Page.
Click OK.

The Job Notes window appears. Enter user and job identification information for
accounting purposes, or whatever information is required at your site, and click OK.

Completing the SMB printing connection

If you don't have a Novell network, you can print via SMB printing (also known as
Windows printing or WINS printing). Printing by this method allows you to print
from your computer to a particular print connection (Hold, Print, or Direct) on the
Fiery X2.

To set up printing to a second or third print connection, you must install a new printer
for each connection and repeat the procedure “To set up SMB printing:” on page 15.

If you install more than one printer, give each a descriptive name during printer driver
installation, such as Astro-Print or Astro-Hold, so you can easily identify printers.

BEFORE YOU BEGIN:

1.

Configure the Fiery X2 for SMB printing in Network Setup>Service Setup>Windows
Setup.

SMB printing is referred to as Windows Printing in Setup, on the Control Panel Map,
and on the Configuration page. For more information, see the Administrator Guide.
Print the Fiery X2 Configuration page.

You need information from the Configuration page to specify settings on your
computer, such as the Server Name and IP address of the WINS Name Server.

Save any documents in open programs.

You are prompted to restart Windows after this procedure, so be sure to save any
documents.
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TO PREPARE YOUR COMPUTER FOR SMB PRINTI

NG:

1. Click Start, choose Settings, and click Control Panel.

2. Double-click the Network icon.

3. Select TCP/IP and click Properties.

Network

Configuration | Identificationl Aocess Eontroll

The following network components are installed:

Client for Microzoft Metworks

Client for Metware Metworks

MFS Maestra for Windows 95 - Client
3Com Etherlink |1l Bus-Master PCI Ethernet Adapter
|F/5F-compatible Protocal

Add... | Remove |

Properties

Frimary Metwork Logomn:

IEIient far Microsaft Metworks

File and Frint Sharing... |

Drescription

TCPAP iz the pratocol pou use to connect to the Intermet and

wide-area networks.

0K

| Cancel

4. Click the WINS Configuration tab.
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5. Select “Enable WINS Resolution” and enter the TCP/IP address of the WINS Name
Server.

The TCP/IP address of the WINS Name Server is listed on the Configuration Page in
the Network Setup section.

TCFP/IP Properties EHE
Bindings | Advanced | DS Configuration I
Gateway WINS Configuration | IP Address

Contact your network. administrator to find out if you need to
configure your computer for 'WIMS.

" Disable 'WINS Resolution

FErimary 'wIMNS Server: l:l
Secondary WINS Server. l:l

Scope |D:

= Use DHCP for WINS Resolution

()8 I Cancel |

6. Click OK, and click OK at the Network dialog box.

You are prompted to restart Windows. Click Yes, and when Windows restarts,
continue with the following procedure.

TO SET UP SMB PRINTING:
1. Click the Start button, choose Settings, and click Printers.
2. Click the icon for the printer and choose Properties from the File menu.

3. Click the Details tab in the Properties window and click Add Port.
A list of connection options is displayed.

4. In the Add Port dialog box, click Browse to display your network environment.
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Expand the levels to locate your printer and the print connection (Print, Hold, or
Direct) to which you want to print.

Browse for Printer EHE

e

Browse

Al

o B Fred

/- B Testsmb
/- B Tokyo_351

- B8 Danw-pe J
- B8 Duane-pc

E

E

E

=l

()8 | Cancel |

The printer name you are browsing for is the Server Name listed under Network Setup
on the Configuration Page. This name may not be the same as the Server Name listed
under Server Setup on the Configuration Page (which is the name displayed on the
Control Panel).

The network environment and the amount of network traffic determines the amount
of time required for the Browse function.

Select the print connection under the printer and click OK.

In the Add Port dialog box, verify that the network path is correct and click OK.
To confirm the connection, click the General tab in the Properties dialog box.
Click Print Test Page, and click OK.

The Job Notes window appears. Enter user and job identification information for
accounting purposes, or whatever information is required at your site, and click OK.

If the test page prints successfully, you are ready to print from the computer.
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Setting up PostScript printing with Windows 3.1x

You can use the following procedure whether you are installing from the User Software
CD or with installer files downloaded using the Installer WebTool.

TO INSTALL THE FIERY X2 PPD FILE FOR WINDOWS 3.1X:

1.

2.

In the Main window, double-click the Control Panel icon.

Double-click the Adobe PostScript Printers icon.
The Install PostScript Printer from PPD dialog box appears.

Note: If there is no Adobe PostScript Printers icon in the Control Panel window, you
need to install the Adobe PostScript printer driver from the User Software CD.
Proceed to the procedure “To install the Adobe PostScript printer driver for
Windows 3.1x:” on page 18.

If you are installing from the CD, in the Drives hox, select the drive containing the CD.

If you are installing from the installer files you downloaded with the Installer
WebTool, in the Drives box, select your hard disk drive.

If you are installing from the CD, in the Directories box, double-click to open the
English\Instalrs\Ps_drvr\Win_31 folders.

If you are installing from the installer files you downloaded with the Installer
WebTool, in the Directories box, double-click to open the Prntdrv\Ps_drvr\Win_31
folders.

Select the appropriate Fiery X2 PPD from the Printer Descriptions available box and
click Install.

For the 5750, select Fiery X2 5750 v3010.104.

For the 5790, select Fiery X2 5790 v3010.104.

For the 5799, select Fiery X2 5799 v3010.104.

Click OK when you are notified that the printer was successfully installed.
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TO INSTALL THE ADOBE POSTSCRIPT PRINTER DRIVER FOR
WINDOWS 3.1X:

1. Exit all applications and close all windows.
2. Insert the User Software CD into the CD-ROM drive.

3. In the Windows Program Manager, choose Run from the File menu, and then click
Browse.

4. If you are installing from the CD, in the Directories box, double-click to open the
English\Instalrs\Ps_drvr\Win_31 folders.

If you are installing from the installer files you downloaded with the Installer
WebTool, in the Directories box, double-click to open the Prntdrv\Ps_drvr\Win_31
folders.

5. Select the Setup.exe file, and click OK.

6. Click OK in the Run dialog box.
The README.WRI dialog box appears.

7. Click Read to view the README file. When you are finished, close the README file and
click Continue.

The necessary files are installed to your hard disk. When installation is complete, the
PostScript Printer Driver Setup dialog box appears.

8. Click Restart Windows. After the computer restarts, return to the procedure “To install
the Fiery X2 PPD file for Windows 3.1x:” on page 17.

Setting the Fiery X2 as the default printer with Windows 3.1x

You can specify the Fiery X2 as the default printer. Many Windows applications use
the default printer when you choose the Print command.

TO SET THE FIERY X2 AS THE DEFAULT PRINTER:

1. In the Control Panel window, double-click the Printers icon.

The Printers window appears.

2. Select the Fiery X2 from the Installed Printers box.
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3.

Click Set As Default Printer.
The Fiery X2 appears in the Default Printer area of the Printers window.

Completing the Windows 3.1x connection

To print from Windows 3.1x you need to:

« Configure a port on each Windows 3.1x computer for the network or connection
type

« Complete setup for the network type you are printing over

« Set up the Fiery X2 to accept print jobs from your computer

Selecting a printer port with Windows 3.1x

When you install a printer, Windows assigns it to a default printer port. If the Fiery X2
is connected to your computer through a network or you want to assign it to a
different port, you need to change the port assignment. Check with your system
administrator about which port to use.

You can also use this procedure to enable printing with the parallel port.

TO SELECT A PRINTER PORT:

1.

2.

3.

In the Control Panel window, double-click the Printers icon.
In the Printers window, select the Fiery X2 in the Installed Printers list box.

Click Connect.

=-| Connect
i _Cancel |
[T Local Port m
LPT2: Local Port
LPT3: Local Port Mot Present ellings=
COM1: Local Port Mot Present
COM2: Local Port
[ Timeouts [seconds] Help I
Device Mot Selected: EI
Transmission Retry:

O East Printing Direct to Port
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Connect the Fiery X2 to the same port as your network.

For parallel printing, select the port (LPT1, LPT2, or LPT3) connected to your
parallel cable.

To print to a file, select FILE. Printing to a file is useful if the Fiery X2 is elsewhere or
off-site. However, if you select the FILE port, you cannot print to a printer until you
select a network or printer port. (In some applications, you can select the FILE port
from the Print dialog box; this is preferable for temporary use since it doesn't require
resetting the port in the Control Panel.)

Click OK.

The Printers window appears again, with the selected port next to the selected printer
name in the Installed Printers list box.

When you are finished, click OK and then click Close.

Setting up IPX (Novell) printing with Windows 3.1x

To SeT UP IPX (NOVELL) PRINTING:

1.

In the Main group of the Windows Program Manager, double-click the Windows Setup
icon.

From the Options menu, choose Change System Settings.

=-| Windows Setup -
Options  Help
Display: T ision 1024-32 lerated ¥1.3 small
Keyboard: Enhanced 101 or 102 key U5 and Hon US
Mouse: Microsoft, or IBM P52
Network: No Network Installed

From the Network pop-up menu, choose Novell NetWare (shell versions 3.26 and
above).

=-| Change System Settings
Display: |Tluevision 1024-32 accelerated ¥1.3 small font |£I
Keyboard: |Enhanced 101 or 102 key US and Hon U5 keyboards |£I
Mouse: |Micmsoﬂ, or IBM P5/2 |£I
Hetwork: |§Novell MetWare [shell versions 3.26 and above] |£I

| 1] 4 I | Cancel I | Help I
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4. Click OK. When prompted, restart Windows.
5. In the Main group, double-click Control Panel, then double-click Printers.
6. In the Printers Control Panel window, select the Fiery X2 and click Connect.

7. Click Network.

If you are printing to a file, select FILE. Printing to a file is useful if the printer is
elsewhere or off-site. However, if you select the FILE port, you cannot print to a
printer until you select a network or printer port. If you select Network, the next
window depends on the NetWare client driver version.

8. If the Network Printer Connections dialog box is displayed, select the port in the
Printer connections box.

9. In the Available queues list box, select the server and queue name that correspond to

the Fiery X2.

10. Click the Capture button, then click the Close button.
The Connect dialog box is displayed with the network path to the Fiery X2.

11. Click OK in the Connect dialog box.

The Printers window appears again, with the selected port next to the selected printer

name in the Installed Printers list box.

12. Click Close in the Printers dialog box.

You are now ready to print to the Fiery X2 from Windows applications. When you
select Print, jobs are routed to the print queue on the NetWare file server, and then

sent to the Fiery X2. The network administrator should verify the network connection
by printing a test document from each networked computer that will use the Fiery X2.

Setting up PostScript printing with Windows NT 4.0

To set up Windows N'T 4.0 printing, install the Windows NT PostScript printer driver

and configure printing for your network type. Fiery X2 printer files support
Intel-based Windows NT 4.0.

Some features of the Fiery X2 may not be available when using the Windows NT
PostScript printer driver. For details, see the User Guide.
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You can use the following procedure whether you are installing from the User Software
CD or with installer files downloaded using the Installer WebTool.

TO INSTALL THE FIERY X2 AS A LOCAL PRINTER WITH THE
WINDOWS NT 4.0 POSTSCRIPT PRINTER DRIVER:

1. If you are installing from the CD, insert it into the CD-ROM drive.
2. Click Start in the Windows NT taskbar, choose Settings, and then choose Printers.
3. Double-click Add Printer.

4. To install a printer locally, select My Computer and click Next.

Add Printer Wizard

This wizard helps you install yaur printer or make printer
connections. This printer wil be managed by

& iy Compuiter

Al settings wil b managed and configured on tis
computer,

" Natwark printer sarver

Connect to a printer on anather machine. Al settings for
this printer are managed by o print server that has been set
up by an admiristrator.

ik [ Mews | Cancd |

“My Computer” is available if you logged in to a computer on which you have
Administrator privileges. If it is not available, you can add a network printer. The
procedure is similar to adding a port (see page 29).
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5. Check LPT1: and click Next.

This is a general installation that works for the parallel port connection. You can add a
network port later, according to your network type.

Add Printer Wizard

Click the check bax nett ta the portls] you want to uss
Documents wil print ta the first available checked port.

Available ports
Port

[ Desciipion | Frinter [~
Local Part

Local Port
Local Port
Local Port
Local Port
Local Port
Local Port =

Add Port | Configure Part.._ |

™ Enable printer pooling

<Beck [ West> | Cancel |

6. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

Add Printer Wizard

Click the manufacturer and madel of your printer, | your printer came with an
b installation disk, click Havs Disk. If your printe is not listed, sansult yaur
piinter decumentation for a compatible printer.

Manufacturers: Frinters

i’ AGFa-AccuSet v52.3 ﬁ!
AGFA-AccudetsF vB23
AGFA-AccuSet 800
AGFA-AccuTet BO0SF v52.3
AGFa-AccuSet BI0SF v2013.108
AGFa-AccuSet 1000
LI ARFA-AccuS et TAONSFE vA2 3 LI

Have Disk...

<Bock [ News | Cancel |

The Install from Disk dialog box prompts you for the disk.

Install From Disk

Insert the manufacturer's installation disk into the diive o
@ selected, and then ciick DK [ ]

Cancel

LCopy manufacturer's files from:

ﬁ =] Browse.




24 | Installing User Software on a Windows Computer

7. If you are installing from the CD, type the name of the CD-ROM drive (for example,
D:\), and click Browse.

If you are installing from the installer files you downloaded with the Installer
WebTool, type the name of your hard disk drive (for example, C:\), and click Browse.

8. If you are installing from the CD, browse to the English\Instalrs\Ps_drvr\WIN_NT4x
folder and click Open.

If you are installing from the installer files you downloaded with the Installer
WebTool, browse to the Prntdrv\Ps_drvrA\WIN_NT4x folder and click Open.

Make sure “Ntprint.inf” is selected in the Look in box.
The path is copied to the Install from Disk dialog box.

9. Verify the path is correct, and click OK.

Install From Disk
Insert the manufacturer's installation disk inta the diive g
selected, and then dlick OK.
Cancel

LCopy manulacturer's files from:

D:\PSOption\ENGLISHUNSTALRSWPS_DRVANWI = | Browse.

10. In the Printers box, select the appropriate Fiery X2 PPD file and click Next.

For the 5750, select Fiery X2 5750 v3010.104.
For the 5790, select Fiery X2 5790 v3010.104.
For the 5799, select Fiery X2 5799 v3010.104.

Add Printer Wizard

./..;9 Click the manufacturer and model of wour printer. |f wour printer came with an
..,!T ¥ installation digk, click Have Disk. [f your printer is not listed, consult wour
printer documentation for a compatible printer.

Frinters:
Fiery <2 5730 +3010.104
Fiery <2 5750 +3010.104
Fiery <2 5799 +3010.104

< Back Mest » Cancel
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11. Using a maximum of 20 characters, enter a name for the Fiery X2 (or leave the default
name) in the Printer name box, and choose whether you want the Fiery X2 to be your
default printer. Click Next.

Note: Entering more than 20 characters may cause printing problems with some
network applications.

Add Printer Wizard

Type in the name of this printer. When pou have
finished, click Mext

Nate: Exceeding 31 characters in the Server and
Printer name combination may nat bs supported by
some applications

Etinter name:

[stra

Do you want your Windows based pragrams to use this
printe as the default printer?

C Yes
g

<Bak [ MNews | Cancd |

12. Indicate whether you want the printer installed as a shared printer. Click Next.

Add Printer Wizard

Indicate whether this printer will be shared with other
network users. |f you choose sharing give this printer a
share name.

£ Shared

a4

Select the operating systems of all computers that will be
printing to this printer.

it 95 -
windows NT 4.0 MIPS
wfindos WT 4.0 Alpha

windows NT 4.0 PRPC

efindows WT 3.5 or 351 86

windows NT 3.5 or 3.51 MIPS =l

<Beck [ West> | Cancel |

If you select Shared, you must also enter a Share Name for the printer (or leave the
default name) and make selections from the list of operating systems used by client
workstations. For information on shared printers, see the Administrator Guide.

13. Click No in the next dialog box to postpone printing a test page, and click Finish.
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TO COMPLETE INSTALLATION OF THE FIERY X2 WITH THE
WINDOWS NT 4.0 POSTSCRIPT PRINTER DRIVER:

If the Files Needed dialog box appears, it prompts you to locate the Pscript.dll file.

Files Needed

The file PSCRIPT.DLL' on Windows NT ‘workstation [iT3
= CD-ROM is needed
Cancel

Tupe the path whers the fils is located, and then dlick
ok
Skip File

Browse...

Copy files from

ld: 386

1. If this is the first PostScript printer on your system:
« Eject the User Software CD and insert the Windows NT Installation CD.

« In the text field, type the name of the CD-ROM drive (for example, D:\), and click
Browse.

 Browse to i386 (the folder containing the Pscript.dll file).

If you have already installed a PostScript printer on your system:

« In the text field, type the name of the hard drive (for example, C:\), and click
Browse.

 Browse to winnt\system32\spool\drivers\w32x86 (the folder containing the
Pscript.dll file).
2. Click OK, then click OK in the Files Needed dialog box.

When installation is complete, the Printers window appears with an icon for the newly
installed printer.
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3. Complete the printer connection according to your network type.

To do this: See:

Configure the parallel connection “Completing the Windows NT 4.0
parallel port connection” below

Configure the TCP/IP (Ipr port) “Completing the Windows NT 4.0

connection TCP/IP connection” on page 28

Configure the IPX (Novell) “Completing the Windows NT 4.0 IPX

connection (Novell) connection” on page 31

Completing the Windows NT 4.0 printer connection
To print from Windows NT 4.0 you need to:

« Set up network servers, if any
« Set up the Fiery X2 to accept print jobs from your computer
« Configure a port on each Windows NT computer for the network or connection

type

Completing the Windows NT 4.0 parallel port connection
The parallel port cable connects the Fiery X2 to a single computer.

Once you have installed the Windows NT PostScript printer driver and the Fiery X2
PPD, complete the setup for parallel port printing.
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TO SET UP PARALLEL PRINTING FOR WINDOWS NT 4.0:
1. Click the Start button, choose Settings, and then choose Printers.

2. Double-click the Fiery X2 icon and choose Properties from the Printer menu.
In the Ports tab, confirm that LPT1 (Local Port) is checked.
The Fiery X2 is ready to accept parallel print jobs from your computer, using the
Windows NT PostScript printer driver and the Fiery X2 PPD.

3. Click the General tab and click Print Test Page.

4. Click the Sharing tab if you want to share the Fiery X2 with network users. Select
Shared, and select a share name.
Select the operating system or systems used by your network clients if you want to
install a printer driver that those clients can download.

5. Click OK to exit the Printer Properties dialog box.

Completing the Windows NT 4.0 TCP/IP connection

Once you have installed the Windows NT 4.0 PostScript printer driver and the
Fiery X2 PPD, complete the setup for the TCP/IP and lpr connection as follows:

« Prepare the Fiery X2 to accept print jobs using TCP/IP and Ipr protocols. (For
details, see the Administrator Guide.)

« Configure the workstation for the TCP/IP connection.

Before you continue, ask the system administrator for the IP address assigned to the
Fiery X2, as well as the subnet mask and the gateway address, if they are used.

The TCP/IP Protocol and Microsoft TCP/IP Printing software should already be
installed on the Windows NT workstation.
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To SeT UP TCP/IP AND LPR PRINTING FOR WINDOWS NT 4.0:

1. Open the Properties dialog box for the Fiery X2, and click the Ports tab.

& Fiery X2 5799 v3010.104 Properties [ 7] =]

General Perts | Scheduing | Sharing | Seeuity | Device Setiings |
Fiery %2 5799 v3010.104
o

Frint to the following portfs]. Documents will print to the first free

checked port
Port | Description | Prirter [=]
LPT1: Local Port
CIepr2: Local Port
ClLpra: Local Port
I com: Local Port
[ comz Local Port
[ comz: Local Port
s e Bt = |
Add Por.. Delete Port Configue Port.. |

I Erreble i sional suppor
I~ Enable printer posiing

Cancel

2. Click Add Port.
The available port types are displayed.

Printer Ports [ 2] x]

Avyailable Printer Ports:

Lexmark DLC Network Port
Lexmark TCP/AP MNetwork Port
Local Port

LPR Part

Mew Moritor.

3. Select LPR Port and click New Port.

If the LPR port is not listed, install the TCP/IP protocols. See the Administrator Guide
or your Windows NT documentation.



30

Installing User Software on a Windows Computer

Enter the IP address of the Fiery X2.

Add LPR compatible printer [x]

MNarne or address of server providing Ipd:

C |
Mame of printer or print queue on that server ﬂl
Help

If your network uses Domain Name Services (DNS), enter the DNS name assigned to
the Fiery X2 instead of the IP address.

Press Tab and type the internal name of the Fiery X2.
The name must be one of the following:

print_5750
hold_5750
print_5790
hold_5790
print_5799
hold_5799

Note: This name is case-sensitive; type it exactly as shown above.

Click OK.

The workstation checks the address or DNS name you entered and notifies you if it
cannot resolve the address.

Click Close in the Printer Ports dialog box.

The new port configuration is reflected in the Ports tab. You should now print a test
page to verify the connection.

Click the General tab and click Print Test Page.

When you print, your PostScript files are sent over the LPR Port connection to the
Fiery X2.

Click OK to close the Printer Properties dialog box.
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Completing the Windows NT 4.0 IPX (Novell) connection
Complete the setup for the IPX (Novell) connection as follows:

« Configure the Novell network and file server for handling Fiery X2 print jobs.

The file server should be configured with a print server and print connection for the
Fiery X2. For details, see your NetWare documentation.

* Prepare the Fiery X2 for IPX printing.
« Set up the IPX connection on the workstation.

NetWare protocols (NWLink IPX/SPX Compatible Transport) and NetWare client
services should already be installed on the Windows NT workstation.

To SET UP IPX (NOVELL) PRINTING FOR WINDOWS NT 4.0:
1. Double-click Network Neighborhood.

2. Double-click NetWare or Compatible Network.
A list of NetWare servers is displayed.

File Edt View Help

[P color_lab ElDeva4l

&P development = Green
P o 411 J=1 kst
4 1og_server = Samba

|1 obiect(s) selected 4

3. Double-click the NetWare Tree or File Server on which the network administrator
defined a print connection for the Fiery X2.

You may have to log in to the file server as a guest to see the print connections.

4. Double-click the print connection defined for the Fiery X2.
If the NetWare server does not have a suitable driver for the Fiery X2 you may be asked
if you want to set up the printer on your workstation.

@ Before you can use the printer ' strohcolor_serverg' t must be sel up on your camputer, Do you want Windows to sel up

the prirter and continue this operation’s
i |
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Click Yes.
The Add Printer Wizard appears.

Specify if you print from MS-DOS programs and click Next.
If you select Yes, you will need to capture a printer port before continuing.

Install the Fiery X2 PPD (start with step 6 on page 23).

When installation is complete, a new printer window appears, with the name of the
print queue on the NetWare server.

Choose Properties from the Printer menu and click the Ports tab.

The NetWare queue you just connected to is listed and checked as a port for the
Fiery X2.

#® color_serverq on Seiver Properties HE

General Ports | Scheduing | Sharing | Secuity | Device Settings |

;% colon_sever
py "

Bint to the follawing ports). Documents wil print ta the fist free
checked port

Fart [ Deseription [ Frinter =]
[CIFILE: Local Port
[mK
3 Serve color_se
< | ;Ij
Add Port DeletePort | CorfiqwePort. |

I | ErieblE biditestional support
I Enable printer posing

Click the General tab and click Print Test Page.

The Fiery X2 polls the NetWare server for print jobs in the print connection defined
for the Fiery X2. When you print, your PostScript files are spooled to that connection
and sent over the queue “port” to the Fiery X2.

The test page job is listed in the queue window until it is printed.
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Installing Fiery X2 software

The User Software CD includes software installers for three Fiery utilities and one
Fiery plug-in. This software is supported with Windows 95 and Windows NT 4.0
only, and must be separately installed on each user’s computer.

Fiery Downloader and Fiery Print Calibrator

The installers for two of the Fiery utilities (Fiery Downloader and Fiery Print
Calibrator) are the same. Before you begin the installation, determine the following:

* Where do you want to install the utility on your hard disk?

By default, the installer places the utility in a folder named “Fiery” on the top level
of your hard disk.

» What do you want to name the utility folder in the Windows\Start Menu\Programs
folder?

By default, the installer names the folder “Fiery.”

To INSTALL FIERY DOWNLOADER AND FIERY PRINT CALIBRATOR:

1.

2.

On the User Software CD, browse to the English\Instalrs folder.

If you are installing Fiery Downloader, double-click to open the Download\Disk1
folders.

If you are installing Fiery Print Calibrator, double-click to open the Calib\Disk1
folders.

Double-click the Setup.exe icon.
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4. Follow the instructions in the Setup dialog boxes to complete installation.

Choose Destination Location m
Name of dialog box
Setup will install Fieny Downloader in the following directony.

Toinstall to this directory. click Next N
Instructions
Taoinstall to a different directory, click Browse and select another
directony.

“ou can choose notto install Fiery Downloader by clicking Cancel to
exit Setup.

Destination Directar
’7(3 \Figny, Browse... ‘

Click when finished _
< Back Dlext > Cancel |

Use the table below as a guide when installing Fiery Downloader and Fiery Print
Calibrator. For specific instructions, read the information in each dialog box.

Name of dialog box: Action: When finished:

Welcome Read the Setup program Click Next.
introduction.

Choose Destination Location Specify a hard disk location for the Click Next.
installed utility software.

Select Program Folder Specify a folder name for the utility | Click Next.
software located in the Programs
menu.

Start Copying Files Verify the information in the Click Next.

Current Settings area.

Information Acknowledge that the software Click OK.
installation is complete.
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Fiery Spooler

The installer for Fiery Spooler is different from the installers for the other Fiery
utilities. In addition to the Fiery Spooler utility software, the installer also installs Java
files necessary to use Fiery Spooler. Before you begin this installation, determine the
following:

< Where do you want to install the utility on your hard disk?

By default, the installer places the utility in a folder named “FierySpooler” on the
top level of your hard disk.

< What do you want to name the utility folder in the Windows\Start Menu\Programs
folder?

By default, the installer names the folder “FierySpooler.”

TO INSTALL FIERY SPOOLER:

1. On the User Software CD, double-click to open the English\Instalrs\Spooler\Disk1
folders.

2. Double-click the Setup.exe icon.

3. Follow the instructions in the Setup dialog boxes to complete installation of
Fiery Spooler.

Use the table below as a guide when installing Fiery Spooler. For specific instructions,
read the information in each dialog box.

Name of dialog box: Action: When finished:

Welcome Read the Setup program Click Next.
introduction.

Choose Destination Location Specify a hard disk location for the Click Next.
installed utility software.

Select Program Folder Specify a folder name for the utility | Click Next.
software located in the Programs
menu.

Start Copying Files Verify the information in the Click Next.

Current Settings area.
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Name of dialog box:

Action:

When finished:

your computer in order to use the
Fiery Spooler software.

Java (TM) Support Indicate that you want to install Java | Click Yes.
files onto your hard disk.
These files are necessary for using
Fiery Spooler.
Java (TM) Support Read the License Agreement. Click Yes.
Java (TM) Support Acknowledge that the installation of | Click OK.
Java files is complete.
Java (TM) Support Indicate that you want to restart Click Yes.

Fiery Scan

The Scan folder contains the TWAIN Fiery Scan module installer. This installer
automatically creates a folder named Twain_32 in the Windows folder on your hard
disk, and then installs the Fiery Scan plug-in module into that folder.

You can access the Fiery Scan plug-in from Adobe Photoshop using the TWAIN
module. For details, see the User Guide.

Note: Before installing the TWAIN Fiery Scan module, make sure the TWAIN
plug-ins (installed with Adobe Photoshop software) are located in the correct
Photoshop\Plugins subfolder. If the TWAIN plug-ins have been deleted, you must
reinstall Adobe Photoshop software in order to use Fiery Scan.

To INSTALL THE TWAIN FIERY SCAN MODULE:

1. On the User Software CD, double-click to open the English\Instalrs\Scan\Disk1

folders.

2. Double-click the Setup.exe icon.
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3.

Follow the instructions in the Setup dialog boxes to complete installation of the

TWAIN Fiery Scan module.

Use the table below as a guide when installing the TWAIN Fiery Scan module. For

specific instructions, read the information in each dialog box.

installation is complete.

Name of dialog box: Action: When finished:
Welcome Read the introduction. Click Next.
Information Acknowledge that the software Click OK.

Using the software for the first time

Before you can use the newly installed software, you must properly configure the

connection to the Fiery X2.

Configuring the connection to the server

The first time you use one of the Fiery utilities or Fiery Scan, you are prompted to
configure the connection to the Fiery X2.The same configuration is used for Fiery

Downloader, Fiery Print Calibrator, and Fiery Scan, so any change in the configuration
affects all of these. The procedure for configuring the connection with Fiery Spooler is

different and is described on page 40.

BEFORE YOU BEGIN:

If you are using IPX/SPX, print the Configuration page from the Control Panel and note

the IPX address and Server Name (in Server Setup) for the Fiery X2.

In general, you should use the Ethernet IPX address. If you are connected through a
Token Ring network, use the Token Ring IPX address.

If you are using TCP/IP, print the Configuration page from the Control Panel and note

the IP Address of the Fiery X2.

You can also set up a Domain Name Server (DNS) for the IP address of the Fiery X2 in

the printcap file and use that name. See your Windows system documentation for

information.
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TO CONFIGURE THE CONNECTION TO THE FIERY X2:

1. Launch Fiery Downloader or Fiery Print Calibrator by double-clicking its icon or by
choosing it from the Start>Programs menu.

Launch Photoshop, and open Fiery Scan (for details, see the User Guide).

2. Click OK.

No Servers Configured m

@ Click OK to configure now or Cancel to do it later.

[ QK I Cancel |

3. Enter the appropriate information for the Fiery X2.

Nickname—Enter a name for the Fiery X2. This name can be any name you wish; it
does not have to match the actual Server Name of the Fiery X2.

Note: The Nickname cannot contain any of the following seven characters:
[1_""<space> <tab>

Protocol—Choose the type of network protocol you are using from the pop-up menu.

Server Name—If you are using the TCP/IP protocol, enter the IP address (or DNS
name) of the Fiery X2. If you are using the IPX protocol, enter the actual Server Name
of the Fiery X2 as it was defined during Server Setup.

IPX Address—(This area is enabled only if you choose IPX from the Protocol pop-up
menu.) Enter the IPX Address of the Fiery X2.

New Device—Enter the name of the device that the Fiery X2 is connected to: 5750,
5790, or 5799. This device name appears in the Printer Setup section of the
Configuration page.
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Mickname I Mickname I
— Communication Ty — Communication Ty
Pratocol ITCPHP =l Pratocol I‘PX =l
Server Mame I Server Mame I
[EFAddress P Address
N O O [ 1
Mew Device Mew Device
| o | 2l
— Devices — Devices
Eermoe Eermoe
i | Cancel i | Cancel
For TCP/IP networks For IPX/SPX networks

4. When you have entered all the information, click Add.

5. With the device name (5750, 5790, or 5799) selected in the Devices list, click OK.

The Fiery X2 appears in the list of available servers. The first line of the entry displays
the nickname you gave the server, followed by the protocol you chose. The second line
displays the device name.

Choose Printer Device

Available Servers Protacol

Add...

Modify... |

] | Cancel |

6. With the device name (5750, 5790, or 5799) selected in the list of Available Servers,
click OK to begin using the software.
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Modifying the configuration

You should edit the configuration whenever there is any change to your Fiery X2 server
or network, such as a Server Name, IP Address/IPX Address, or device change. First
change the specific Fiery X2 Setup information before configuring the connection.

TO MODIFY THE CONFIGURATION:

1.

To edit information for a Fiery X2 in the list of available servers, select the Fiery X2 by
its nickname and click Modify. Edit information in the Modify Server Settings dialog
box as necessary, and click OK when finished.

To add a new Fiery X2 to the list of available servers, click Add. Configure the Add New
Server dialog box as outlined in step 3 through step 5 above.

To remove a Fiery X2 from the list of available servers, select the Fiery X2 by its
nickname and click Remove; then click Yes in the Remove dialog box.

Configuring the connection for Fiery Spooler

The first time you launch Fiery Spooler, you are prompted to configure a connection
to the Fiery X2. This configuration procedure is different from that for the other Fiery
utilities.

TO CONFIGURE THE CONNECTION FOR FIERY SPOOLER:

1.

Launch Fiery Spooler by double-clicking its icon or by choosing it from the
Start\Programs menu.

Click Option.

E:':jchuoser !Em

Awailable Servars

Option Refresh 0] Cancel
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3. Click Add.
i Configure !Em
Manually configured servers

OK
Cancel

Add.
EErEyYE
alerefiig

4. Enter the appropriate information for the Fiery X2.
Name—Enter the IP address (or DNS name) of the Fiery X2.

New Device—Enter the name of the device that the Fiery X2 is connected to: 5750,
5790, or 5799. This device name appears in the Printer Setup section of the
Configuration page.

5. When you have entered all the information, click Add.

6. With the device name (5750, 5790, or 5799) selected, click OK.

The Fiery X2 appears in a list of configured servers.

7. Click OK in the Configure dialog box.
The Fiery X2 appears in a list of available servers.

: Chooser !En

Awailable Servers

& 172161 46_5798

Refresh | QK | Cancel |

8. With the Fiery X2 selected in the list of available servers, click OK to begin using
Fiery Spooler.
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Modifying the configuration

You should edit the configuration whenever there is any change to your Fiery X2 server
or network, such as an IP Address or device change. First change the specific Fiery X2
Setup information before configuring the connection.

TO MODIFY THE CONFIGURATION:
1. In the Chooser dialog box, click Option.

2. To edit information for a Fiery X2, select the Fiery X2 by its IP address or DNS name
and click Modify. Edit information in the Settings dialog box as necessary, and click OK
when finished.

3. To add a new Fiery X2, click Add. Configure the Settings dialog box as outlined in
step 4 through step 6 above.

4. To remove a Fiery X2, select the Fiery X2 by its IP address or DNS name and click
Remove.

5. Click OK in the Configure dialog box.
The list of available servers reflects the modifications you have made.

Copying color files from the User Software CD

You can copy additional color files from the User Software CD to your hard disk.
Many of the files are PostScript files that you can download and print using
Fiery Downloader.

The User Software CD contains the following color files:

Icm folder ICM printer profiles specially designed for use with the
Fiery X2, your particular copier model, and the Windows
color management system. For instructions on installing these
profiles, see “Installing the Fiery X2 ICM printer profile for
Windows 95” on page 44.
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Photoshp folder

Clrfiles folder

Calibrat folder
(inside Clrfiles
folder)

Demo.mea

Separation Tables for use with Adobe Photoshop and the
Fiery X2. The Separation Tables match RGB-to-CMYK
conversions performed in Photoshop to those performed on
the Fiery X2 by color rendering dictionaries (CRDs).
Calrgh.ams, a monitor settings file that sets the proper source
color space.

For instructions on installing these files, see “Installing files for
Adobe Photoshop” on page 44.

Cmyk_ref.ps, an 11-page, letter-size PostScript file to use for
reference when defining CMYK colors in applications.
PANTONE.ps, a 19-page, letter-size PostScript file that
indicates the closest equivalent of PANTONE coated colors
that the Fiery X2 and your particular copier model can
produce. The method used to print the Pantone.ps file differs
depending on the Spot Color Matching setting. For more
information, see the User Guide.

Rgb_01.doc, a file you can print from Microsoft Word 6.0 or
later to view available RGB colors.

Rgb_02.ppt, a file you can print from PowerPoint 4.0 or later
to view available RGB colors.

Four PostScript measurements files of color patches:
custom21.ps, custom34.ps, stand21.ps, and stand34.ps.

The numbers in the filenames refer to the number of patches
on the page.

The Custom files are provided to enable you to download
measurement patches that incorporate the copier’s current
calibration set. The Standard files are provided to enable you to
download standard measurement patches that ignore the
copier’s current calibration set.

Note: These files are provided for expert users and should not
be used for day-to-day calibration.

Demo Measurement, a sample measurements file for use with
Fiery Print Calibrator. This file is for demonstration purposes
only and should not be used to calibrate the Fiery X2.
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Installing the Fiery X2 ICM printer profile for Windows 95
Use the following procedure to install the Fiery X2 ICM printer profile.

Note: The ICM printer profile should not be installed for printing with the Microsoft
Office 97 suite of applications. If you print from Microsoft Office 97 with the ICM
profile installed, JPEG, BMP, and TIFF images print incorrectly.

To INSTALL THE ICM PROFILE:

1.

2.

On the User Software CD, open the Icm folder.

Copy the ICM profile that corresponds to your copier to the Windows\System\Color
folder on your hard disk.

For the 5750, select Efmx5010.icm.
For the 5790, select Efmx3010.icm.
For the 5799, select Efmx7010.icm.

In the Color folder, right-click to select the ICM profile.
Choose Install in Place from the menu that appears.

Install In Place

Install To Color Directory

Send To 3

Cut
Copy

Create Shortcut
Delete
Fename

Froperties

In the Windows\System\Color folder, the icon for the ICM profile is now white,
indicating that it is installed.

Installing files for Adobe Photoshop

If you use Adobe Photoshop, install the Separation Tables and the Calrgh.ams monitor
settings file for best color printing results. These files are found on the User Software
CD in the Photoshp folder.

Note: The Calrbg.ams monitor settings file should be loaded before using Fiery Scan.
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Loading the Separation Tables

The Separation Tables enable RGB-to-CMYK conversions within Photoshop that
correspond to conversions performed by color rendering dictionaries on the Fiery X2.

TO LOAD THE SEPARATION TABLES:

1.

2.

On the User Software CD, open the Photoshp folder.

Copy the appropriate files for your copier to the Adobe Photoshop folder.

For the 5750, copy the files X5750mxp.ast and X5750mxs.ast.
For the 5790, copy the files X5790mxp.ast and X5790mxs.ast.
For the 5799, copy the files X5799mxp.ast and X5799mxs.ast.

Launch Photoshop.

For Photoshop 4.0, from the File menu, choose Color Settings, and from the Color
Settings submenu, choose Separation Tables.

For Photoshop 3.0 and Photoshop 2.5, from the File menu, choose Preferences, and
from the Preferences submenu, choose Separation Tables.

In the Separation Tables dialog box, click Load.

Separation Tables =]
-~ ToCMYWK
|
& Use Separation Setup
) Use Table __Cencsl |
Load.
~ Fram CMYK
Save..
& Use Brinting Irks Setup
) z= Tieble

Build Tables Lsing ICC Profiles I

Browse to the Adobe Photoshop folder, select the appropriate file, and click Open
(Photoshop 4.0) or OK (Photoshop 3.0 or 2.5).

Select the <copier model>p.ast file for separating photographic RGB images to CMYK.
Select the<copier model>s.ast file for separating solid color RGB images to CMYK.
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7. Verify that the file you selected appears after “Use Table:” in both places and

click OK.
Separation Tables [X]

. ToChVK i

 Use Separation Setup

& Use Table 55799mup. ast _ Corcel |
 From CMYK

Save.
" Use Erinting Inks Setup
& se Table: %5793rmxp. ast
Build Tables Lsing ICC Profiles: |

Separation tables remain loaded the next time you start Photoshop, unless you remove
them.

Loading the monitor settings file

The Calrgh.ams monitor settings file for Photoshop defines the source color space for
printing to the Fiery X2.

Note: If you use Fiery Scan, you should install the Calrgb.ams monitor settings file.

TO LOAD THE MONITOR SETTINGS FILE:
1. On the User Software CD, open the Photoshp folder.
2. Copy the Calrgb.ams file to your Adobe Photoshop folder.
3. Launch Photoshop.

4. For Photoshop 4.0, from the File menu, choose Color Settings, and from the Color
Settings submenu, choose Monitor Setup.

For Photoshop 3.0 or Photoshop 2.5, from the File menu, choose Preferences, and
from the Preferences submenu, choose Monitor Setup.
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5. In the Monitor Setup dialog box, click Load.

Monitor: [ Default = —
Moritor Parameters -Eaml
Gamma: W _I
WhitePoit [6500% =] Load...
Bhosphors: [ Trmwon =] _Sae. |
Fioom Parameters |
Calibrate..

[ Ambient Light: [ Mediurm -

6. Browse to your Adobe Photoshop folder, select the Calrgb.ams file, and click Open
(Photoshop 4.0) or OK (Photoshop 3.0 or 2.5).

The Calrgh.ams file appears as the selection in the Monitor pop-up menu of the

Monitor Setup dialog box.

Monitor Setup
Wonitor: [ Calrgb.ams =
Monitor Parameters Cancel

Gamma: [220
-Lnad
white Point: [ S000°K, 2 =
Save
Phasphors: [ Custorn... -
Room Pararneters
LCalibrat
’V Ambient Light: | High = =

7. Under Room Parameters, set Ambient Light to High and click OK.
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Installing Mac OS software

The general steps for installing the Fiery X2 user software and setting up printing on a
Mac OS-based computer are:

Install the Adobe PostScript printer driver and Fiery X2 PostScript Printer
Description file (PPD).

Set up the Fiery X2 in the Chooser.

Install the Fiery utilities (Fiery Downloader, Fiery Print Calibrator, and
Fiery Spooler), and Fiery Scan plug-in.

Install the screen fonts.
Install the ColorSync™ profiles.

Copy additional color-reference and application-specific files from the User Software
CD as needed.

nstalling Mac OS software

The Installers folder on the User Software CD contains the following installer folders:

ColorSync™ Profiles Installer—Fiery X2 ColorSync ICC profiles installer
Fiery Downloader—Fiery Downloader installer
Fiery Print Calibrator—Fiery Print Calibrator installer

Fiery Scan—Fiery Scan installer, which installs the Fiery Scan (TWAIN) plug-in and
Fiery TWAIN plug-in

Fiery Spooler—Fiery Spooler installer

Printer Driver—Adobe PostScript printer driver and PPD installer

Note: An installer is not provided for the Mac OS screen fonts; they must be copied
directly from the User Software CD to the System Folder:Fonts folder on your hard
disk. For instructions, see “Screen fonts” on page 56.
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In addition, the User Software CD contains various color files. These files must be
copied or installed from the CD and placed in the appropriate locations on your hard
disk (see “Copying color files from the User Software CD” on page 57).

PostScript CMYK color reference file
PostScript PANTONE Coated color reference file

* RGB color reference files for specifying colors from Microsoft Word and PowerPoint
« Separation Tables and a monitor settings file for use with Adobe Photoshop

Note: If you operate the Fiery X2 in a copy shop, quick print shop, or service bureau,
you might want to provide copies of the printer driver, PPD file, separation tables, and
relevant documentation to customers. This ensures that jobs they prepare are properly
formatted for printing to the Fiery X2.

Downloading printer files with the Installer WebTool

Installers for the Fiery X2 printer files can be downloaded from the Fiery X2 with the
Installer WebTool (if the site administrator has enabled Internet access to the
Fiery X2). For instructions, see “Using the Installer WebTool” on page 64.

Once you download the installers, the installation process is identical to installing from
the User Software CD.

Setting up PostScript printing with Mac OS

To set up the Fiery X2 as a PostScript printer, you must install the Adobe PostScript
printer driver, and the PPD file that corresponds to your copier. The AdobePS printer
driver and PPD file are provided on the User Software CD.

Printer drivers provide a way to communicate information on print jobs between your
applications, the Fiery X2, and any other PostScript printer connected to your
computer.

You can use the following procedures whether you are installing from the User
Software CD or with installer files downloaded using the Installer WebTool.
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TO INSTALL THE ADOBEPS PRINTER DRIVER AND PPD FILE:
1. If you are installing from the CD, open the Installers:Printer Driver folder.

If you are installing from the installer files you downloaded with the Installer
WebTool, open the Printer Driver folder on your hard disk.

2. Double-click the AdobePS Installer icon.
A warning dialog box appears.

Your Macintosh needs to be restarted after
A installation is complete. Do you wish to
continue?

3. Click Yes to continue with installation of printer driver software, and to confirm that
your computer must be restarted after installation.

The AdobePS Installer installs the Adobe PostScript printer driver, the PPD file that
corresponds to your copier, and the Apple Chooser.

4. Click Restart when installation is complete.

Installation was successful. In order to
s take advrantage of the new software, your

Macintosh needs to be restarted.

Setting up the Fiery X2 in the Chooser

After you install the AdobePS printer driver and PPD file (see “Setting up PostScript
printing with Mac OS” on page 50), you need to set up the Fiery X2 in the Chooser in
order to take full advantage of its features. This section describes how to set up the
Fiery X2 with the AdobePS printer driver.
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To SET UP THE FIERY X2 IN THE CHOOSER:

1.

2.

Select Chooser from the Apple menu.

Click the AdobePsS icon.

Make sure AppleTalk is set to Active.

Eiee—————

Chooser

AdobePS #ppleShare

I

<

Select a PostScript Printer:

AppleTalk Zones:

15t Floor EtherTalk
2nd Floor Development
2nd Floor EtherTalk
Building 2600 2nd F1
Building 2755 3rd F1
Building 2855 1st F1
Building 2855 2nd F1
Building 368 2nd F1

] =3

Aero-NT
AERO_Direct
AERO_Hold
AERO_Print

& Archipelago
Archipelago-NT
Astro_Hold

£ Astro_Print

B stlas

) Active

AppleTalk ) Inactive

7.5.4

3. Select the correct AppleTalk Zone, if necessary.

4,

5.

Select the Fiery X2 from the “Select a PostScript Printer” list, and click Setup.

The Fiery X2 appears in the list in the form of <server name>_<device hame>_ <print
connection>. The device name (5750, 5790, or 5799) is the name of your copier.The
AdobePS printer driver automatically selects the correct PPD file for your Fiery X2.

Note: Only the print connections that are available appear in the Chooser. Each
Fiery X2 print connection (Direct, Hold, and Print) has a separate name, and you will
need to set up each print connection separately. Repeat step 4 for all enabled

connections.

Close the Chooser.
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Installing Fiery X2 software and fonts

Before you begin each of the following installation procedures, determine where you
want to install each item on your hard disk. By default, the files are placed in the
following locations:

« The ColorSync Profiles are placed in the System Folder:Preferences folder on your
hard disk.

If your system uses ColorSync, you must install these profiles in the ColorSync
Profiles folder inside the System Folder:Preferences folder. You should install the
ColorSync profiles only if your system uses them.

« Fiery Downloader is placed in a folder named “Fiery” on the top level of your hard
disk.

« Fiery Print Calibrator is placed in a folder named “Fiery” on the top level of your
hard disk.

« Fiery Scan is placed on the top level of your hard disk. You are prompted to locate
your Photoshop plug-ins folder.

The installer also creates a folder named TWAIN in your System Folder:Preferences
folder, and then installs a Fiery Scan module and a Source Manager file into that
folder. You must then install the Fiery Scan (TWAIN) plug-in module into the
appropriate Photoshop folder in order to use it.

Note: Before installing the Fiery TWAIN module, make sure the TWAIN plug-in
(installed with Adobe Photoshop software) is located in the correct Photoshop\Plugins
subfolder. If the TWAIN plug-in has been deleted, you must reinstall Adobe
Photoshop software in order to use Fiery Scan.

« Fiery Spooler is placed in a folder named “Fiery” on the top level of your hard disk.

Note: An installer is not provided for the Mac OS screen fonts; they must be copied
directly from the User Software CD to the System Folder:Fonts folder on your hard
disk. For instructions, see “Screen fonts” on page 56.
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To INSTALL MAC OS SOFTWARE:

1. On the User Software CD or your hard disk, double-click to open the Installers folder.

If you are installing: Double-click:
ColorSync profiles To open the ColorSync™ Profiles Installer folder
Fiery Downloader To open the Fiery Downloader folder
Fiery Print Calibrator To open the Fiery Print Calibrator folder
Fiery Scan To open the Fiery Scan folder
Fiery Spooler To open the Fiery Spooler folder

2. Double-click the Installer icon.

3. Click Install.
Install the following:
. Fiery Downloader |
Software to be installed
=
@ Fiery Downloader
Inztallation requires : 1408k
Disk space required for _
installation [ ouit ][ instan |

4. Specify the locations into which to install each item.
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Use the table below as a guide when installing software.

If you are installing:

Action:

To install:

ColorSync Profiles

Browse to the System Folder:
Preferences: ColorSync™ Profiles folder.

Click Install into
“ColorSync™

Fiery Print Calibrator software.

Perform the steps in “To set the ColorSync | Profiles.”
system profile:” on page 56 after installation
is complete.

Fiery Downloader Specify a hard disk location for the installed | Click Install.
Fiery Downloader software.

Fiery Print Calibrator Specify a hard disk location for the installed | Click Install.

Fiery Scan

Specify where to install the Fiery Scan
(TWAIN) plug-in. The folder into which
you install the plug-in depends on the
version of Photoshop you are using.

For Photoshop 4.0, browse to the
Photoshop:Plug-ins:Import/Export folder.

For Photoshop 3.0x, browse to the
Photoshop:Plug-ins:Acquire/Export folder.

For Photoshop 2.5, browse to the
Photoshop:Plug-ins folder.

Click Install into
“(foldername).”

Fiery Spooler

Specify a hard disk location for the installed
Fiery Spooler software.

Click Install.

5. If prompted, click Quit to close the software installer.
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To SET THE COLORSYNC SYSTEM PROFILE:

1. For ColorSync Profiles, choose Control Panels>ColorSync System Profile from the Apple
Menu.

2. Click Set Profile.

3. From the list of ColorSync profiles, select EFIRGB ICC and click Select.

=

ColorSync™ System Profile

214
Set Profile...

s

EFIRGE

When selected as the ColorSync system profile, EFIRGB ICC sets the optimal source
color space for printing to the Fiery X2. The color space set by the EFIRGB ICC
profile is the same as that set by the EFIRGB setting of the RGB Source print option.

Note: The RGB Source print option setting overrides the ColorSync system profile
setting.

4. Close the ColorSync System Profile window.

Screen fonts

The User Software CD includes screen fonts that correspond to the 136 built-in
PostScript printer fonts on the Fiery X2. In order to view and use these fonts, you must
copy them from the User Software CD to your hard disk.

TO INSTALL SCREEN FONTS:
1. On the User Software CD, open the Fonts folder.

2. Copy the fonts that you want to install to the System Folder:Fonts folder on your hard
disk.

If you have any applications open, you must quit and relaunch them before the newly
installed screen fonts are available.
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Copying color files from the User Software CD

You can copy additional color files from the User Software CD to your hard disk.
Many of the files are PostScript files that you can download and print using
Fiery Downloader.

The User Software CD contains the following color files;

Photoshop folder ~ Separation Tables for use with Adobe Photoshop and the
Fiery X2. The Separation Tables match RGB-to-CMYK
conversions performed in Photoshop to those performed on
the Fiery X2 by color rendering dictionaries (CRDs).
Calibrated RGB, a monitor settings file that sets the proper
source color space.

For instructions on installing these files, see “Installing files for
Adobe Photoshop” on page 58.

ColorFilesfolder CMYK Color Reference.ps, an 11-page, letter-size PostScript
file to use for reference when defining CMYK colors in
applications.

PANTONE Book.ps, a 19-page, letter-size PostScript file that
indicates the closest equivalent of PANTONE coated colors
that the Fiery X2 and your particular copier model can
produce. The method used to print the PANTONE Book.ps
file differs depending on the Spot Color Matching setting. For
more information, see the User Guide.RGB page 01, a file you
can print from Microsoft Word 6.0 or later to view available
RGB colors.

RGB page 02, a file you can print from PowerPoint 4.0 or later
to view available RGB colors.
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Calibration Four PostScript measurements files of color patches:

folder (inside custom21.ps, custom34.ps, standard21.ps, and standard34.ps.
Color Files The numbers in the filenames refer to the number of patches
folder) on the page.

The Custom files are provided to enable you to download
measurement patches that incorporate the copier’s current
calibration set. The Standard files are provided to enable you to
download standard measurement patches that ignore the
copier’s current calibration set.

Note: These files are provided for expert users and should not
be used for day-to-day calibration.

Demo.mea Demo Measurement, a sample measurements file for use with
Fiery Print Calibrator. This file is for demonstration purposes
only and should not be used to calibrate the Fiery X2.

Installing files for Adobe Photoshop

If you intend to use Adobe Photoshop, install the Separation Tables and the monitor
settings file for best color printing results. These files are located on the User Software
CD in the Photoshop folder.

Note: For best results, the monitor settings file should be installed if you use
Fiery Scan.

Loading the Separation Tables

The Separation Tables enable RGB-to-CMYK conversions (in Photoshop), which
correspond to conversions performed by color rendering dictionaries on the Fiery X2.

TO LOAD THE SEPARATION TABLES:

1.

2.

On the User Software CD, open the Photoshop folder.

Copy the appropriate files for your copier to the Adobe Photoshop folder.

For the 5750, copy the files Fiery X2 5750.P and Fiery X2 5750.S.
For the 5790, copy the files Fiery X2 5790.P and Fiery X2 5790.S.
For the 5799, copy the files Fiery X2 5799.P and Fiery X2 5799.S.

Launch Photoshop.
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4. For Photoshop 4.0, from the File menu, choose Color Settings, and from the Color
Settings submenu, choose Separation Tables.

For Photoshop 3.0 or Photoshop 2.5, from the File menu, choose Preferences, and from
the Preferences submenu, choose Separation Tables.

5. In the Separation Tables dialog box, click Load.

Separation Tables

— To CMYK
0K
@ Use Separation Setup
C |

) Use Table:
— From CMYK -

@ Use Printing Inks Setup

) Use Table:

[ Build Tables Using ColorSync... ]

6. Browse to your Adobe Photoshop folder, select the appropriate Separation Table file,
and click Open.

Select the <copier model>.P file for separating photographic RGB images to CMYK.
Select the <copier model>.S file for separating solid color RGB images to CMYK.

7. Verify that the file you selected appears after “Use Table:” in both places and click OK.

Separation Tables

To CMYK

s soprat
2 Use Separation Setup
@ Use Table:  Fiery H2 5799.P
From CMYK

{J Use Printing Inks Setup
@ Use Table:  Fiery H2 5799.P

[ Build Tables Using Apple ColorSync... ]

Separation tables remain loaded the next time you start Photoshop, unless you remove
them.
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Loading the monitor settings file
The Calibrated RGB monitor settings file for Photoshop defines the source color space
for printing to the Fiery X2.

Note: For best results, the monitor settings file should be installed if you use
Fiery Scan.

TO LOAD THE MONITOR SETTINGS FILE:
1. On the User Software CD, open the Photoshop folder.
2. Copy the Calibrated RGB file to your Adobe Photoshop folder.
3. Launch Photoshop.

4. For Photoshop 4.0, from the File menu, choose Color Settings, and from the Color
Settings submenu, choose Monitor Setup.

For Photoshop 3.0 and Photoshop 2.5, from the File menu, choose Preferences, and
from the Preferences submenu, choose Monitor Setup.

5. In the Monitor Setup dialog box, click Load.

Monitor Setup

Monitor: | Other A
— Monitor Parameters
Gamma:

White Point:

Phosphors:

— Room Parameters
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6. Browse to your Adobe Photoshop folder, select the Calibrated RGB file, and click Open.

The Calibrated RGB file appears as the selection in the Monitor pop-up menu of the
Monitor Setup dialog box.

Monitor Setup

Monitor: | Calibrated RGB Rd|
— Monitor Parameters
Gamma:
Load...
White Point:

Phosphors:

— Room Parameters

Ambient Light:

7. Under Room Parameters, set Ambient Light to High and click OK.
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Downloading
Installers with
Fiery WebTools

Fiery WebTools allow you to manage your Fiery X2 remotely from the Internet or
from your company’s intranet. The Fiery X2 has its own home page, from which you
are able to select from a variety of functions including WebSetup, Status, WebSpooler,
WebLink, and Installer.

For more information on using Fiery WebTools, see the User Guide.

Setting up Fiery WebTools

In order for network users to access and use Fiery WebTools, you need to set certain
Fiery X2 options in Setup from the Control Panel. You also need to prepare each user’s
workstation to communicate with the Fiery X2 over the Internet or intranet.

For more information about Fiery X2 Setup, see the Administrator Guide.

To VERIFY THAT FIERY WEBTOOLS ARE SET UP ON THE

FIERY X2:

1.

Print the Configuration page from the Control Panel.

For instructions, see the User Guide.

On the Configuration page, check the following:

« In Network Setup>Port Setup, confirm that the appropriate network type (Ethernet
or Token Ring) is enabled.

« In Network Setup>Protocol Setup>TCP/IP Setup, confirm that TCP/IP is enabled
and that there is a valid, unique IP Address for the Fiery X2.

* In Network Setup>Service Setup, confirm that Web Services are enabled.

« In Printer Setup, confirm that the Print Queue is published.
If all the conditions listed in Step 2 are currently set, the Fiery X2 is properly set up
to use Fiery WebTools.

If any of the conditions listed in Step 2 are not currently set, you must change them (as
described in the Administrator Guide) before you can use Fiery WebTools.
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To SET UP FIERY WEBTOOLS ON EACH USER’S WORKSTATION:

1.

2.

3.

Enable TCP/IP networking.
Make sure the workstation has a valid, unique IP address.

Make sure the workstation is installed with one of the following Internet browsers:

Windows 95 and Windows NT—Either Netscape Communicator v4.0.4 or Microsoft
Internet Explorer v3.0.2

Mac 0S—Netscape Communicator v4.0.4
Note: Netscape and Microsoft continue to release frequent updates to their browsers.

As support cannot be guaranteed for all versions, use the versions specified above for
best results.

Make sure Java is enabled in your Internet browser.

For more information on setting up the Fiery X2 and your network, see the
Administrator Guide.

Using the Installer WebTool

The Installer WebTool duplicates the printer driver installers on the User Software
CD, allowing you to easily download the current version of printer files from the
Fiery X2 to your workstation.

TO DOWNLOAD THE PRINTER FILES INSTALLERS WITH THE
INSTALLER WEBTOOL:

1.

2.

Launch your Internet or intranet browser and enter the DNS name or IP address of the
Fiery X2.
Select a login level, enter a password if necessary, and click OK.

No password is required to log in as Guest. You have full access to the Installer
WebTool when logged in as Guest.
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3. Click the Installer button.

2§ Fiery WebTools: Fiery X2 - Microsoft Internet Explorer

Efi & WebTools

Fiery X2 Macintosh

Status Printer Files
VwehSpooler
WebLink
Installer

WebSetup

Windows
Printer Files

3 [ [ [@ntemet zone =

4. Under the name of your operating system, click “Printer Files.”

For Windows computers, a dialog box appears, prompting you to save the file
“Prntdrve.exe” to the location you choose.

For Mac OS computers, a folder named “Printer Driver” is downloaded to the desktop
in a BinHex-encoded, compressed format. If your internet browser is equipped with an
expander utility such as Stufflt Expander, the folder will be decoded and decompressed
automatically.

5. For Windows computers, browse to the location where you want to save the
Prntdrve.exe file and click Save.

For Mac OS computers, if the Printer Driver folder was not automatically decoded and
decompressed, launch a utility that will perform that function.
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6. For Windows computers, double-click the Prntdrve.exe file, browse to the location
where you want to install the Prntdrv folder, and click Next.

The Prntdrv folder is installed to the location you specified.

7. Install the appropriate printer files for your operating system.

For instructions: See:

Windows 95 “Setting up PostScript printing with Windows 95” on page 3
Windows 3.1x “Setting up PostScript printing with Windows 3.1x” on page 17
Windows NT 4.0 “Setting up PostScript printing with Windows NT 4.0” on page 21
Mac OS computers “Setting up PostScript printing with Mac OS” on page 50.
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This chapter provides troubleshooting tips.

On a Windows computer

Setting up IPX (Novell) printing for Windows NT Workstation

If you have problems installing the Fiery X2 with Windows NT, try installing another
PostScript printer (such as the Apple LaserWriter 11g), and then install the Fiery X2.
Installing another printer insures that all files are properly installed and available. For
instructions, see your Windows NT documentation.

Installing the Adobe PostScript Printer Driver

If you are reinstalling the Adobe PostScript Printer Driver, delete any previous versions
and related files before installing. Search for and delete all files named Efmx*.* in the
Windows\System folder and the Windows\System\Color folder. See the Adobe
READMIE file included with the printer driver for more information.

Problems with the Fiery utilities on Windows 95 or Windows NT
If you are using Windows 95, make sure that IPX/SPX and TCP/IP networking protocols
are both enabled.

See “Completing the Windows 95 IPX/SPX or IPX (Novell) connection” on page 10.

Make sure that the connection is configured correctly for your site.

To check the current configuration, launch a Fiery utility and choose Open from the
File menu. Select the Fiery X2 and click Modify to see current settings. If the settings
are incorrect, you can change them in this dialog box.
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On a Mac OS computer

Setting up the Fiery X2 in the Chooser

If auto-setup does not work and you are prompted to select the PPD, select the
appropriate Fiery X2 file in your System Folder:Extensions:Printer Descriptions folder.

For the 5750, select Fiery X2 5750 v3010.104.
For the 5790, select Fiery X2 5790 v3010.104.
For the 5799, select Fiery X2 5799 v3010.104.

Installing screen fonts

If you experience problems installing the PostScript screen fonts from the User
Software CD to the System Folder:Fonts folder, try the following:

1. Quit all applications and close all windows.

2. Create a new folder and name it “Uninstalled Fonts.”

This folder must be located outside of the System Folder.

3. Move fonts that you are not using from the System Folder:Fonts folder to the
Uninstalled Fonts folder.

4. Continue to copy fonts from the User Software CD to the System Folder:Fonts folder.
5. Create an alias to the System Folder:Fonts folder and to the Uninstalled Fonts folder.
6. Place both aliases on your desktop.

7. When necessary, use the aliases to open both folders and move fonts between them.

If you have any applications running, you must quit and relaunch them in order to
view and use the newly installed fonts.

Alternately, you can try combining fonts from multiple suitcases into a single suitcase.
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installing for Mac OS 53
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installing for Windows 33 to 34
overview Xi
Fiery Scan Plug-in for Photoshop
installer for Mac OS 47
installer for Windows 1, 32
installing for Mac OS 53
installing for Windows 36
overview Xi
requirements Xiii
system requirements xv
Fiery Spooler
configuring the connection 40 to 41
installer for Mac OS 47
installer for Windows 1
installing for Mac OS 53
installing for Windows 34
overview Xi
supported protocols xiv
Fiery TWAIN module xi, 36, 51
Fiery utilities
configuring the connection 37 to 41
installing for Mac OS 51
installing for Windows 32
problems on Windows 95 or
Windows NT 65
requirements for Mac OS xv
requirements for Windows xiii
See also Fiery Downloader, Fiery Print
Calibrator, Fiery Spooler
Fiery WebTools
Installer xi, 2, 3, 23, 62 to 64
setting up 61
system requirements Xiii, xv
version of browser required xiii, 62
fonts
Adobe PostScript 3 x
Adobe Type 1 xi
installing 47, 48
Multiple Master x
screen fonts xi, 54 to 58
substituting in PDF files x

troubleshooting 66
TrueType X, Xi
Fonts folder 66
Frame Type option 11

|
i386 folder 26
ICM color management files xii
Icm folder (Windows) 42
ICM printer profiles 2, 42, 43
installers
Mac OS 47, 48
Windows 1,2
Installers folder 47
Installer WebTool, see Fiery WebTools
installing
ColorSync Profiles 52
Fiery Downloader (Mac OS) 52
Fiery Downloader (Windows) 33 to 34
Fiery Print Calibrator (Mac OS) 52
Fiery Print Calibrator (Windows) 33 to
34
Fiery Scan Plug-in (Mac OS) 52
Fiery Scan Plug-in (Windows) 36
Fiery Spooler (Mac OS) 52
Fiery Spooler (Windows) 35
ICM profile 43
PostScript printer driver (Mac OS) 49
PostScript printer driver
(Windows 3.1x) 17
PostScript printer driver
(Windows 95) 3to 6
screen fonts 54 to 58
software for Mac OS 51
software for Windows 32
TWAIN module (Windows) 36
Instalrs folder 1
internal name 30
Internet Explorer xiii, 62
IP address xiii, xv, 13, 37
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IPX
system requirements xvi
Windows 3.1x 20 to 21
Windows 95 12
Windows NT 4.0 30, 31 to 32
IPX address 37
IPX/SPX
configuring the connection 37
Windows 95 10

J
Java 62
JPEG images 43

M
Mac OS
copying color files 55
Installer WebTool 48
installing Fiery utilities 51
installing software 52
Power Macintosh xv
screen fonts 54 to 58
system requirements xiv
troubleshooting 66
memory, amount required Xxiii, Xiv, xv
Microsoft Office 97, see Office 97
modifying the configuration (Windows) 41
monitor settings file
Mac OS 58 to 59
Windows 45 to 46
MS-DOS, versions required xiv

N
Netscape Communicator Xxiii, 62
NetWare
network port with Windows 3.1x 21
network port with Windows 95 12
NetWare client setup
Windows 3.1x 20
Windows 95 10, 12
NetWise networking features x
Ntprint.inf file 23

0
Office 97 43

P
PANTONE color reference files 2, 42, 48,
55
parallel port
system requirements xv
Windows 3.1x 19 to 20
Windows 95 7 to 10
Windows NT 4.0 28 to 31
PDF files x, xi
Photoshop
files (Mac OS) 48, 55
files (Windows) 2, 42
plug-ins xi
version 2.5 or later required for Fiery
Scan plug-in xiii
Photoshop folder 55
Photoshop Separation Tables
Mac OS 56 to 58
Windows 44 to 45
Photoshp folder (Windows) 42
PostScript
printing with Mac OS 48
printing with Windows 3.1x 16
printing with Windows 95 3
printing with Windows NT 4.0 21
screen fonts xi
PostScript Level 1 x
PostScript Printer Description file, see PPD
PostScript printer driver
downloading 62 to 64
installer for Mac OS 47, 49
installers for Windows 1
version 3.0 for Windows 3.1x xiv
version 4.2 for Windows 95 xiv
version 8.5 for Mac OS xiv
Windows 3.1x 17
Windows 95 3to 6
PowerPoint, RGB color reference file 48, 55
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PPD

Mac OS 49

overview Xi

Windows 3.1x 17

Windows 95 5

Windows NT 4.0 24
Print command (Windows) 18
printer drivers, see Postscript printer drivers,

Windows NT 4.0 printer drivers

printing

Mac OS 48

Windows 3.1x 16

Windows 95 3

Windows NT 4.0 27
Print Test Page option 16
Prntdrve.exe file 64

R

remote server management 61
RGB color reference files 2, 42, 55

S
Separation Tables see Photoshop Separation
Tables

Server Name 13
SMB printing, see Windows 95
Solaris, supported version xv
specifications, color server x
Spooler, see Fiery Spooler
stand21.ps (Windows) 43
stand34.ps (Windows) 43
standard21.ps (Mac OS) 56
standard34.ps (Mac OS) 56
SunOS, support version xv
System 7 xiv, see also Mac OS
system requirements

IPX xvi

Mac OS xiv

parallel port xv

UNIX xv

Windows Xxiii

T
TCP/IP
configuring the connection 37
printing software conforming to
RFC1179 xv
supported by color server x
test page 16
thicknet cable x
thinnet cable x
TIFF images 43
Token Ring, optional kit x
troubleshooting
Mac OS computers 66
Windows computers 65
TWAIN folder 51

U

Uninstalled Fonts folder 66

UNIX workstations, system requirements xv

unshielded twisted pair (UTP) cable x

User Software CD
Adobe PS Printer Driver xi
contents (Mac OS) 47, 48
contents (Windows) 1, 2, 32
installing from (Mac OS) 49, 55
installing from (Windows) 3, 42
overview Xi
troubleshooting fonts 66

W
WebSpooler, see Fiery WebSpooler
WebTools, see Fiery WebTools
Windows
copying color files 42
installers 1
installing software 32
system requirements xiii
troubleshooting 65
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Windows 3.1x Windows NT 4.0
configuration ports on 18 IPX 31t032
connection 18 printer driver 2, 22
IPX printing 20 to 21 printing from parallel port 28 to 31
PostScript printer driver 17 printing requirements 27
PPD 17 system requirements Xiv
selecting parallel port 19 to 20 setting up PostScript printing 21
setting default printer 18 troubleshooting 65
system requirements Xxiv Windows NT Installation CD 26
Windows 95 WINS Name Server 13, 16
IPX/SPX 10 Word, RGB color reference file 48, 55

parallel port 7 to 10
PostScript printer driver 3 to 6
SMB printing 13 to 16
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